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Volt MXによるモバイルアプリ開発
はじめの⼀歩 Step 1
Launch your First Mobile App
最初のモバイルアプリの起動



Copyright © 2022 HCL Technologies Limited  |  www.hcltechsw.com 2

このコースの前提条件
Step 0.トライアルアカウントの作成とVolt MX Iris インストール

の終了後に、このコースを開始して下さい。



Volt MX Iris

Launch your First Mobile App
最初のモバイルアプリの起動
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Volt MX Irisを起動し、テストアカウントでログイン
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Learn More を選択して、Hike（チュートリアル）を起動
環境により起動直後の画⾯が異なる場合があります。いずれかの⽅法でHikeを起動します。

Learn More をクリック 左側メニューの⼀番下の
アイコンをクリック
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最初のモバイルアプリの起動

"Launch your
First Mobile App"

を起動
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Launch your First Mobile App

START
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Welcome to Volt MX Iris

Startをクリック
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(1/11) Welcome to Volt MX Iris
Welcome to Volt MX Iris
Let’s get started!
In this hike, we will:
• Import a sample native app that shows lists of 

Accounts and Recipients.
• Preview the sample app on a mobile device.
Before you get started,
• Install the Volt MX App on your mobile device from 

the Google Play Store or the App Store.
• Download and extract the sample csv file from here.

Note the location of the extracted file.
When you are ready, click Start!

Volt MX Irisへようこそ
さぁ、はじめましょう

このハイキングでは、次のことを⾏います。
• アカウントと受信者のリストを表⽰する、サンプルのネ

イティブアプリをインポートします。
• サンプルアプリを、モバイルデバイスでプレビューしま

す。
始める前に
• Google Play StoreまたはApp Storeから、モバイルデ

バイスにVolt MXアプリをインストールします。
• サンプルのcsvファイルをここからダウンロードし、解

凍します。解凍したファイルの場所をメモしておきます。
準備ができたら、Start︕をクリックします。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください

http://127.0.0.1:3000/desktopweb/index.html
https://raw.githubusercontent.com/HCL-TECH-SOFTWARE/volt-mx-tutorials/master/public/samples/SampleCSV.zip
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サンプルのCSVファイルをダウンロードして解凍
https://raw.githubusercontent.com/HCL-TECH-SOFTWARE/volt-mx-tutorials/master/public/samples/SampleCSV.zip

解凍して
内容を確認

https://raw.githubusercontent.com/HCL-TECH-SOFTWARE/volt-mx-tutorials/master/public/samples/SampleCSV.zip
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(2/11) Import the Native App
Import the Native App

1. From the main menu of the Iris, navigate to 
Forge > Browse.
The Volt MX Marketplace windows appears 
after logging in.

2. On the search bar, enter Recipients Mobile.
3. Click the search icon .
4. In the list that appears, select Recipients 

Mobile.
The details of the Recipients Mobile appear.

5. Click Import to Workspace.
It may take some time for Iris to import the 
app.

6. If you have imported this project before, the 
overwrite error dialog may appear, click OK
button to proceed.

7. Click the Continue button.

ネイティブアプリをインポートする

1. Iris のメインメニューから、[Forge] > 
[Browse] に移動します。
ログイン後、Volt MX Marketplace ウィンドウ
が表⽰されます。

2. 検索バーで、Recipients Mobile と⼊⼒します。
3. 検索アイコン をクリックします。
4. 表⽰されたリストで、Recipients Mobile を選択

します。
Recipients Mobile の詳細が表⽰されます。

5. [Import to Workspace] をクリックします。
Iris がアプリをインポートするのに時間がかかる場
合があります。

6. 以前にこのプロジェクトをインポートしたことがあ
る場合、上書きエラーダイアログが表⽰されること
がありますが、[OK] ボタンをクリックして次に進
みます。

7. [Continue]ボタンをクリックします。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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メニューから Forge > Browse を選択
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テスト⽤アカウントでログイン
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検索バーで Recipients Mobile を検索して選択

Recipients Mobile

Recipients Mobile
アプリを選択
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ワークスペースにインポート

Import To Workspace
をクリック

警告が出た場合は
Continue
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アプリケーションのインポートが完了
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(3/11)Open the App
Open the App

1.After the app is imported, a Volt MX Iris dialog 
appears.
Click OK.

2.From the main menu of the Iris, navigate 
to Project > Open > HCL Reference Architecture, 
and select RecipientsMobile.
The application opens in the Storyboard view.

アプリを開く

1. アプリがインポートされると、Volt MX Iris の
ダイアログが表⽰されるので、OK をクリック
します。

2. Iris のメインメニューから、Project > Open 
> HCL Reference Architecture と進み、
RecipientsMobile を選択すると、アプリが
Storyboard ビューで開きます。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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アプリを開く（既に開かれている場合は次に進む）
Project > 

Open > 
HCL Reference Architecture > 

RecipientsMobile

既に開かれている場合は
選択肢に" RecipientsMobile "
が表⽰されません。
次に進みます。
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Storyboard ビューが開きます

RecipientsMobile
が選択されている
ことを確認
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(4/11) Explore the App
Explore the App

Once the application is imported, you can explore the 
different forms in the application.
You can view the forms in two different views: 
The Storyboard view and the Design view.

The application opens in the Storyboard view. You 
can view the different forms inside the app and 
connections between forms in the Storyboard view.

To view Properties of each widget in a form, double 
click on any form to open the form in the Design View. 
You can also select the Design tab to navigate to the 
Design View.

アプリケーションを探索する

アプリケーションをインポートしたら、アプリケーショ
ン内のさまざまなフォームを探索することができます。
フォームは、2つの異なるビューで表⽰することができ
ます。StoryboardビューとDesignビューです。

アプリケーションは、Storyboardビューで開かれます。
Storyboardビューでは、アプリケーション内のさまざ
まなフォームやフォーム間の接続を確認できます。

フォーム内の各ウィジェットのプロパティを表⽰するに
は、任意のフォームをダブルクリックして、そのフォー
ムをDesignビューで開いてください。また、
「Design」タブを選択してデザインビューに移動する
こともできます。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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Storyboardビュー アプリケーション内の
さまざまなフォームやフォーム間の
接続を確認できます

フォームをダブルクリックします
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Designビュー
フォーム内の各ウィジェットの
設計画⾯が表⽰されます
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(5/11) Explore the App
Explore the App

In the Design View, to view the different forms 
inside the app, navigate to the Project explorer, 
and expand Mobile > Forms.

You can see six forms inside the app. Click on 
each form and see what the canvas displays.

アプリの探索

Designビューで、アプリ内のさまざまなフォームを
表⽰するには、プロジェクトエクスプローラに移動
し、［Mobile］＞［Forms］を展開します。

アプリ内に6つのフォームが表⽰されます。各フォー
ムをクリックし、キャンバスに表⽰される内容を確
認します。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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フォームの表⽰

［Mobile］＞［Forms］を展開
各々のフォームの内容を確認
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(6/11) Add Sample User
Add Sample User

1.From the Data & Services panel on the top right of 
your canvas, expand Project Services.

2.Right-click on UserAuthentication and select Edit. 
The Edit Identity Service window appears.

3.Click Import Users. The Import Users window 
appears.

4.Click Choose File. The window explorer appears.
5.Navigate to the location of the exportUsers.csv file, 

select the file and click Open.
6.Click Import.
7.Waiting for imported user successfully notices 

appears.
8.Close the Edit Identity Service window.

サンプルユーザーの追加

1. キャンバスの右上にある［Data & Services］パ
ネルから、［Project Services］を展開します。

2. "UserAuthentication" を右クリックし、Edit を
選択します。[Edit Identity Service（IDサービ
スの編集）]ウィンドウが表⽰されます。

3. [Import Users］をクリックします。[Import 
Users］ウィンドウが表⽰されます。

4. [ファイルを選択] をクリックします。ウィンドウ
エクスプローラが表⽰されます。

5. 最初にダウンロードしたexportUsers.csvファイ
ルの場所に移動して、ファイルを選択し、Openを
クリックします。

6. [開く］をクリックします。
7. "Users  Imported Successfully" が表⽰されます
8. [Edit Identity Service］ウィンドウを閉じます。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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［Project Services］を展開

［Data & Services］パネルから、
［Project Services］を展開
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UserAuthentication を右クリックし、Edit を選択

UserAuthentication を右クリックし、
Edit を選択
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Edit Identity Serviceウィンドウ

[IMPORT USERS]をクリック
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exportUsers.csvを選択

[ファイルを選択]をクリックして、
exportUsers.csvを選択し、[開く]。
IMPORTをクリックします。
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ユーザーが追加されます

1 Users imported successfully と表⽰され、
ユーザーが1⼈追加されます。
パネルを閉じます
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Foundry アプリケーションのパブリッシュ
Webブラウザで、Volt MX Foundry Console (https://manage.demo-hclvoltmx.com/console/)
にアクセスしてログイン

①
[RecipientsMobile]を選択

③
[Publish]ボタンをクリック

※この⼿順は Hikeにはありませんが、アプリの動作確認でログインエラーを回避するために必要です。

④
[APP STATUS]が
[Published]であることを確認

②
[Publish]タブを選択

https://manage.demo-hclvoltmx.com/console/
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※次に進む前に Volt MXアプリのプレビューについて
Volt MX App Preview can be run in 2 modes:

① Running the application that's been 
published on the Cloud
For sharing the app with others
Youʼll need to have the 5-digit code that is 
created when you publish the application

② Running the application locally 
connecting to Iris using Wi-Fi or USB
For testing the application from their 
desktop/laptop

Let see how to publish an Iris preview to the 
cloud

Volt MX App Previewは、
2つのモードで実⾏することができます。

① クラウド上に公開されたアプリを実⾏する
アプリを他の⼈と共有する場合
アプリケーションを公開した際に作成される5桁
のコードが必要です

② Wi-FiまたはUSBでIrisに接続し、ローカルでア
プリケーションを実⾏する
デスクトップ／ラップトップからアプリケー
ションをテストする場合

今回は、Iris プレビューを クラウドに公開する⽅法
について⾒てみましょう。
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(7/11) Volt MX App
Volt MX App

After logging in to the application, we can see 
the various modes available as the menu items 
at the bottom and by default cloud mode is 
selected.

Volt MX App

Volt MX モバイルアプリケーションにログインする
と、下部のメニューに様々なモードが表⽰され、デ
フォルトではクラウドモードが選択されています。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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Volt MX モバイルアプリを起動してログイン

デフォルトでは
Cloud モードが
選択されています
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(8/11) Publish Live Preview

Publish Live preview
1. From the main menu, select Build.

Click Publish Live Preview.
2. From the Publish Live Preview Settings

window, check the boxes next to the OS of 
the mobile device on which you are going to 
publish the app.
For example, iOS and Android.

3. Click Publish.
It may take some time for Iris to publish the 
app.
The Live Preview is ready window appears.
Iris gives you a 5-digit code.

Hikeでは USBケーブルを接続する⽅法を説明して
いますが、ここではクラウド環境を使います。

ライブプレビューを公開する
1. メインメニューから、［Build］を選択します。

[Publish Live Preview]をクリックします。
2. [Publish Live Preview Settings]ウィンドウ

で、アプリを公開するモバイルデバイスの OS 
の横にあるチェックボックスをオンにします。
たとえば iOSとAndroidなどです。

3. Publish をクリックします。
Iris がアプリを公開するのに時間がかかる場合
があります。
Live Preview is ready ウィンドウが表⽰され、
Iris から 5 桁のコードが表⽰されます。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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クラウド環境にアプリをパブリッシュ

①
[Build] > [Publish Live Preview]
を選択

②
[Platform and Channels]
ここでは
[MOBILE] の
"iOS"と"Android"を選択

④
5桁のコードと
QRコードが⽣成されます

③
[Publish]
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(9/11) Launch the App
Launch the App

On your Volt MX App, 

Enter the 5 Digit App View Code and 
LAUNCH

or
Scan the QR code using ʻSCAN QR CODEʼ 
button to preview the application.

アプリの起動

あなたのスマホのVolt MXアプリで

5桁のアプリビューコードを⼊⼒し
LAUNCH
または

'SCAN QR CODE'ボタンでQRコードを読み取り、
アプリケーションをプレビューします。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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サンプルアプリケーションの起動

①
5桁のコードを⼊⼒

②
[LAUNCH]

アプリの終了⽅法
のガイドが表⽰
されます

③
[X] をタップ
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(10/11) View the App
View the App

You will now be able to view the app on 
your mobile device.
1.Enter the following login credentials in your app:

• Username: john.doe@woodburn.com
• Password: VoltMX@123

2.Click Login.
The Accounts List appears.

3.Click Recipients.
The Recipient list appears.

In the Recipients list page, you can do the following:
• Click Add (+), to add a recipient to your account.
• Select a recipient from the list to view their details.
• From the details page, you can edit or delete the 

recipient.
To exit the mobile app, swipe two fingers from left to 
right or shake your mobile device and click Exit App.

アプリを試してみる

ここまでの⼿順により、モバイルデバイスでアプリを表⽰でき
るようになります。
1. アプリに以下のログイン情報を⼊⼒してください。
• ユーザー名: john.doe@woodburn.com
• パスワード: VoltMX@123

2. [Login] をクリックします。
"ACCOUNTS"が表⽰されます。

3. [Recipients］をクリックします。
"Recipients List"が表⽰されます。

"Recipients List"ページでは、以下の操作が可能です。
• 追加(+)をクリックして、受信者をアカウントに追加
• リストから受信者を選択し、その詳細を表⽰
• 詳細ページで、受信者の編集や削除。
モバイルアプリを終了するには、2本指を左から右にスワイプ
するか、モバイル端末を振って、「Exit App」をクリックしま
す。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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アプリを試してみる

①
ユーザー名: john.doe@woodburn.com
パスワード: VoltMX@123

②
紺⾊のバーを
ドラッグして移動
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(11/11) Congratulations
Congratulations

You have successfully:
• Imported a mobile app
• Launched the app on a mobile device using the Volt 

MX App

To learn how to create this app on your own, check 
out the next hike:

2. Create UI from Collections

おめでとうございます︕

あなたは以下のことに成功しました。
• モバイルアプリのインポート
• Volt MXアプリを使⽤して、モバイルデバイス上

でアプリを起動。

このアプリを⾃分で作成する⽅法については、次の
ハイクを参照してください︓

2.コレクションからUIを作成する
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Wi-FiまたはUSBでIrisに接続し、ローカルでアプリを実⾏する場合
⼿順の (7/11) 〜 (9/11) が異なります。
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(7ʼ/11) Volt MX App（ローカルの場合）
Volt MX App

1.Connect your mobile device to your computer using 
a USB cable.
For Android mobile devices, ensure that the user of 
USB is set as Transfer files.
For iOS mobile devices, ensure that trust has been 
established between your device and your 
computer.

2.Launch the Volt MX App on your mobile device.
3.Select the USB tab.

On a successful connection, Volt MX Iris on your 
computer shows a success prompt.

4.From the main menu, select Build.
5.Click Live Preview Settings.

Volt MXアプリ

1. モバイル端末をUSBケーブルでパソコンに接続
します。
Android端末の場合、USBの使⽤者がファイル
転送に設定されていることを確認します。
iOSモバイルデバイスの場合は、デバイスとコン
ピュータの信頼関係が確⽴されていることを確
認します。（WindowsはiTunesが必要です）

2. モバイルデバイスでVolt MXアプリを起動しま
す。

3. USBタブを選択します。
接続に成功すると、コンピュータ上のVolt MX 
Irisは成功のプロンプトを表⽰します。

4. メインメニューから、[Build]を選択します。
5. [Live Preview Setting]をクリックします。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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Windows に iOSを USB接続する場合 iTunesが必要です

Important: USB Tethering for iOS devices on Windows Machine:
Prerequisites - Ensure that the latest version of iTunes is installed on the Windows 
machine. Before you start viewing the app on your iOS device by using the USB 
feature on the Volt MX App, open iTunes on your Windows machine.

重要︓WindowsマシンでのiOSデバイスのUSBテザリング︓
前提条件 - Windowsマシンに最新バージョンのiTunesがインストールされてい
ることを確認してください。Volt MXアプリのUSB機能を使ってiOSデバイスで
テストを開始する前に、WindowsマシンのiTunesを開いてください。
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ローカルでのVolt MXアプリのテスト

[Build] > [Live Preview Settings]
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(8ʼ/11) Run the App（ローカルの場合）
Run the App

1.From the Live Preview Settings window, 
under Native, check the boxes next to the OS 
of the mobile device on which you are going 
to view the app.
For example, iOS and Android.
Ensure that you have unselected the 
checkboxes for all the other platforms and 
channels.

2.Click Save & Run.
It may take some time for Iris to run the app.
The Live Preview is ready window appears

アプリを実⾏する

1. [Live Preview Settings]ウィンドウから、
「Native」の下にある、アプリを表⽰するモバ
イルデバイスのOSの横にあるボックスにチェッ
クを⼊れます。
例えば、iOSやAndroidなどです。
他のすべてのプラットフォームとチャネルの
チェックボックスの選択が解除されていること
を確認します。

2. [Save & Run］をクリックします。
Iris がアプリを実⾏するまでに時間がかかる場
合があります。
Live Preview is ready（ライブ プレビューの
準備ができました）ウィンドウが表⽰されます。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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Live Preview Settings

[Platform and Channels]
ここでは [MOBILE] の
"iOS“ と“ Android"を選択して
Save & Run をクリック。
ビルドに多少時間がかかります。
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USB接続 もしくは Wi-Fi 経由で接続可能に
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(9ʼ/11) Launch the App
Launch the App

On your Volt MX App, click Launch.
You may see an Application Name input box. 
If there is an input box, 
enter RecipientsMobile and then click Launch.

アプリの起動

Volt MX アプリ で、[Launch] をクリックします。
アプリケーション名の⼊⼒ボックスが表⽰される場
合があります。
⼊⼒ボックスがある場合は、
「RecipientsMobile」と⼊⼒し、[Launch]をク
リックします。

これはチュートリアルの翻訳です
作業⼿順は次⾴を参照してください
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USB接続によるアプリの起動

[USB]タブ

USB接続できていない
場合はこの表⽰です[Launch]をタップ

ガイドを閉じる

ユーザー名: john.doe@woodburn.com
パスワード: VoltMX@123

アプリが起動

アプリ名⼊⼒を求められた場合は
[RecipientsMobile]を⼊⼒して
[LAUNCH]をタップ
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Wi-Fi 接続の場合

[Wi-fi]タブ

Irisに表⽰された
IP アドレスと
ポートを⼊⼒

[RecipientsMobile]
と⼊⼒して
[CONNECT]

Wi-fi 接続できない
場合はこの表⽰です

ポートの開放状況
などを確認して
下さい
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